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PROTOCOL PRE-APPROVAL 

The Installation / Operational Qualification Protocol for the Vaisala Veriteq vLog Software Version 4.5 has 

been reviewed and approved for execution by the following.  Signing this protocol indicates that the 

contents of this document have been reviewed, all test procedures are accurate and the acceptance 

criteria are applicable for the intended purpose of this study.  The following responsible functional areas 

have approved this Installation / Operational Qualification Protocol: 

 

Approved By:    ________________________________________   ______________  

Information Technology (Signature) Date 

 _____________________________________________   ________________  

Operations (Signature) Date 

 _____________________________________________   ________________  

Quality Assurance (Signature) Date 
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Disclaimers: 

1. Prior to the execution of this protocol, the following conditions must be met: 

a. Loggers have been attached to the system either directly via a cable connection or indirectly via a vNet 
or Digi PortServer device. 

b. All cables being used that require drivers have been properly installed on the vLog Server.   

c. All vNet and Digi PortServer devices being used have been setup with static IP addresses and correct 
network information, and have had their drivers installed on the vLog Server. 

d. All computers used in the vLog system must meet the minimum requirements as specified in the vLog 
documentation. 

2. The logger data cable must not become disconnected during transmission unless specified in the procedure and 
the logger in test must contain an adequate amount of data. 

3. The procedures in this protocol may not leave the system in an ideal configuration for your particular application, 
especially in the case of an upgrade from a previous version.  Review and modification of the system 
configuration is highly recommended following validation. 

4. When representations of data appear in this protocol, text surrounded by <angled brackets> will be replaced by 
data specific to your installation. 

 

 

 

 

 

 

 

 

 

Vaisala Canada Inc. 

Unit 100 – 13775 Commerce Parkway 

Richmond, BC Canada V6V 2V4 

Tel: (604) 273-6850 

Fax: (604) 273-2874 

Toll Free: 1-800-683-8374 

Email: veriteqsupport@vaisala.com 

Web Site: http://www.vaisala.com 

 

© Copyright 2011 Vaisala Canada Inc.  All rights reserved. Product and company names listed in 

this document are trademarks or trade names of their respective companies. 
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1 Purpose 

The purpose of this IQ/OQ protocol is to provide assurance that the Vaisala Veriteq vLog Data Logging and 
Reporting System has been set up properly, is functional, and operates with a high degree of integrity, 
security and reliability. 

The Installation Qualification (IQ) protocol template has been designed to ensure that the system, composed 
of both the hardware and the software, has been installed correctly at the point of use. The Operation 
Qualification (OQ) protocol template has been designed to ensure that each component of the system 
performs as intended. 

Vaisala Veriteq loggers use Coordinated Universal Time (UTC) to create a base time in every logger file.  
This provides an absolute reference that the Vaisala Veriteq vLog software uses to display the logger 
information using the computer’s local time zone.  Sample files using the Eastern Time Zone have been 
included on the Vaisala Veriteq vLog Qualification Protocol CD in the \Samples\ directory.  When 
implementing this protocol, it is essential that the time zone within the software be set to the Eastern Time 
Zone for particular sections.   

The appendices contain printouts of both sample graph files and tabular data listings.  

2 Responsibilities 

2.1 Vendor Responsibilities 

Vaisala Canada Inc. is responsible for the following: 

• IQ/OQ Protocol Template Creation 

• Initial Logger Calibration  

• Protocol Preparation 

2.2 User Responsibilities 

__________________________ is responsible for the following: 

• Equipment Maintenance 

• Ensuring Calibrated Status of Unit(s) 

• Protocol Pre-Approval 

• Protocol Implementation and Reporting of Results 

• Protocol Execution Deviations, Assessment and Corrective Measures 

• Protocol and Report Review 

• Protocol and Report Approval 

3 System Description 

The Vaisala Veriteq vLog Validatable Data Logging System is a battery-operated, microprocessor-based 
data collection and PC reporting system for monitoring and recording temperature and relative humidity in 
FDA-regulated environments. 

The system consists of one or more VL-1000, VL-1016, VL-1000LT, VL-1000VLT, (hereafter referred to 
collectively as VL-1000); V-1400, VL-1416 (hereafter referred to collectively as VL-1400), VL-1700 
(thermocouples), VL-4000 and/or VL-2000 data loggers; and the Vaisala Veriteq vLog Windows-based 
software.  The data loggers are connected to the vLog System using Vaisala Veriteq serial cables, Vaisala 
Veriteq USB cables, Vaisala Veriteq vNet devices, and/or approved models of Digi PortServer Ethernet 
devices.  The system also comprises a PC with print capability.  Each VL-1000 data logger, except the VLT, 
can optionally include one or more external temperature probes.   
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The VL data loggers are self-contained electronic recording instruments that include on-board sensors, non-
volatile EEPROM memory, a 10-year lithium battery, and a clock. The system is driven by an on-board 
microprocessor operating under Vaisala Veriteq firmware, an unalterable factory-supplied program. 

The temperature sensor used in the VL loggers and in the external temperature probes is a NTC thermistor 
that varies its resistance in relation to temperature. The relative humidity sensor used in the VL-2000 is a 
capacitive sensor. It works by varying its capacitance in relation to changes in RH. Each VL data logger is 
factory-calibrated against NIST traceable standards and all calibration information is encrypted and stored 
digitally in the logger’s memory. The onboard sensors are located just inside the lower left corner of the 
plastic enclosure and are exposed to the ambient environment through ventilation openings in the enclosure. 

The external temperature probe for the VL-1000  and VL-1400 data loggers consists of a short length of two-
conductor, shielded twisted pair cable, with a plug-in connector at one end, and a thermistor, epoxy-
encapsulated in a stainless steel tip or waterproof Teflon tip, at the other end.  The probe can be used to 
provide an additional measurement channel and to allow monitoring in areas not suitable for data loggers. 

The VL-1700 series of data loggers, allows thermocouples to be used, particularly in extreme temperature 
ranges.  Completing the series, the VL-4000 series allows external devices, using Voltage or Current analog 
outputs, to be read and stored. 

The VL data loggers work by sampling and storing sensor readings at regular user-programmed sample 
intervals.  In the VL-2000, both temperature and relative humidity readings are taken simultaneously and 
stored as a set because the response of the RH sensor is temperature-dependent. When the logger data is 
downloaded to a PC, the Vaisala Veriteq vLog software package automatically processes the raw data and 
creates an encrypted file for display, analysis, and reporting. 

The Vaisala Veriteq vLog software package is a commercial off-the-shelf program compatible with Vaisala 
Veriteq VL and SP data loggers, offering data logger setup, graphing, and reporting functions.  The Vaisala 
Veriteq vLog software also includes unique file identifiers and password protection for data integrity. 

4 Objective 

The objective of this protocol is to qualify the installation and operation of the Vaisala Veriteq vLog software 
at __________________________. 

This protocol will verify the installation, correct functionality and operation of the Vaisala Veriteq vLog 
software according to manufacturer’s specifications and the requirements of                                 
__________________________. 

 

5 Documentation Procedures 

5.1 Data generated during the execution of this protocol will be collected and recorded on the data sheets 

provided.  All supplemental information documents will be attached to the protocol. 

5.2 During the execution, the executor’s initials and date will be provided at the time of completion for each 

activity. 

5.3 Handwritten data is to be neatly printed using a black or blue ball point pen.  Corrections are to be lined out 

with a single line, initialed, and dated, with an explanation for the correction. 

5.4 Charts, printout, notes etc. generated during the execution will be dated, signed, and attached to the 

completed protocol document. 

5.5 All pages will be reviewed and signed by appropriate ______________ personnel to verify document 

completeness. 

5.6 Unless specifically required, tests and operational steps may be performed in sequences other than 

indicated. 
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5.7 Throughout this document, the use of N/A and U/A shall be interpreted as “not applicable” and 

“unavailable”, respectively.  A written explanation must be provided whenever U/A is used. 

5.8 Pages may be photocopied as needed in order to complete additional testing or perform testing required to 

resolve deviations/discrepancies.  Additional pages must be numbered appropriately to identify them as 

extra pages and to identify the order in which they appear.  Identification shall be applied using alphabetical 

characters next to the page number and a numeric group annotation to the right of the page number as it 

appears in the header.  For example, if three (3) additional copies of page seven (7) of a forty-one (41) 

page document are required, the page numbering shall be annotated to read as follows: “Page 7A of 41, 

Additional page 1 of 3”. 

5.9 OPTIONAL: Throughout the document (SS) indicates that a screenshot should be taken and attached to the 

protocol. 

5.10 Protocol Definitions 

A discrepancy is defined as: 

• A difference between the expected results and the actual results 

An exception is defined as: 

• A difference between the approved protocol procedure and the procedure followed in testing 

A deviation is defined as: 

• A discrepancy or exception that prevents meeting the acceptance criteria 

Discrepancies, exceptions, and deviations to approved protocols may occur. It is the responsibility of the 
qualification group to document each discrepancy, exception, or deviation and to provide an explanation of 
the circumstances that led to said discrepancy, exception, or deviation. They should be documented in the 
space provided in each test section. 

Discrepancies, exceptions, and deviations must be approved by the Quality Assurance group according to 
current standard operating procedures, prior to any further execution of the protocol. 
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6 INSTALLATION QUALIFICATION 

6.1 Test Plan 

Testing will be performed to verify installation of the Vaisala Veriteq vLog software in conformance with 
manufacturer’s specifications and customer requirements.  The test plan consists of five sections.  These 
are: 

6.1.1 Documentation 

This section will verify the presence of all documentation necessary to qualify, maintain, and operate the 
system properly. 

6.1.2 Logger Information 

This section will verify that all data loggers are properly catalogued. 

6.1.3 Computer Hardware Requirements and Configuration 

This section will verify that all required equipment is present and properly documented, and that it meets 
the hardware requirements of the Vaisala Veriteq vLog system. 

6.1.4 Software Installation Verification 

This section will verify that the correct version of the Vaisala Veriteq vLog software is present and 
properly installed on the PC. 

6.1.5 Test User Security Level Information 

This section will add users with varying levels of security clearance to the system for use in testing. 
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6.2 Documentation 

Record the following information for the system.  Fill in all applicable information. 

Document Criteria 
Storage Location 

(attach copies as necessary) 

Meets Criteria 
Yes / No 

Initials/Date 

Purchase Order / Packing 

Lists 

PO matches items 

received?  Yes / No 
  

vLog installable disks 

Back up disks 

available?  Yes / No 

Location__________   

  

Calibration Program 

Calibration Program 

has been 

documented 

  

Drawings 
Showing installation 

locations 
  

Manuals 
Document # /  
Description 

Storage Location 
(attach copies as necessary) 

Meets Criteria 
Yes / No   

Initials / Date 

Vaisala Veriteq vLog Software 

Quick-Start Guide 

   

Vaisala Veriteq vLog 

User’s Guide 

   

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Sufficient documentation is in place to allow the user to properly install, operate, and 
maintain the system.  All documentation is correct, current, and has been filed. 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.3 Logger Information 

A Vaisala Calibration Certificate supplied with each logger certifies logger accuracy at the time of calibration.  
Vaisala Canada Inc’s state-of-the-art calibration environment and procedures ensure every calibration is 
accurate and traceable to NIST.  If you do not have a Vaisala Calibration Certificate, or if the certificate is out 
of date, the logger can be sent back to the factory for recalibration. 

Record the following information related to the logger(s).  Fill in all information that is applicable.   

This form may be duplicated as needed to complete this section. 

Model # / Location Serial # 
Calibration 
Certificate # 

Calibration Date 
Calibration Due 

Date 

Meets Criteria 
Yes / No     

Initials / Date 

 
     

      

 
     

      

      

      

      

      

      

      

      

      

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Each logger has an up-to-date, uniquely numbered NIST-traceable Vaisala 
Calibration Certificate stating the model number, serial number, calibration 
date, and calibration due date for that particular logger. 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.4 Computer Hardware Requirements and Configuration 

Record the following information for each computer to be used in the Vaisala Veriteq vLog System.  Fill in all 
information that is applicable.   

This form may be duplicated as needed to complete this section. 

PC ID / Location PC Model # Operating System 
Meets Hardware 
Requirements 

Meets Criteria  
Yes / No 

Initials/Date 

     

     

     

     

     

     

     

     

     

     

        
Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Is the Vaisala Veriteq Interface Cable/Device present?  Yes: _____ / No: ______ 

Acceptance Criteria: Each computer must be able to connect to a Vaisala Veriteq data logger using a 
Vaisala Veriteq-approved interface cable or device.  Approved interface cables and devices include the 
Vaisala Veriteq Serial Cable, the Vaisala Veriteq USB cable (with drivers installed), the Vaisala Veriteq vNet 
device, and a selection of Ethernet to Serial devices manufactured by Digi International (with drivers 
installed).  Each computer must be running one of the following approved operating systems: Microsoft 
Windows XP (32-bit and x64), Microsoft Windows Server 2003 (32-bit and x64), Windows Vista (32-bit and 
x64), Windows Server 2008 (32-bit and x64), or Windows 7 (32-bit and x64).  

 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.5 Software Installation Verification  

Follow the steps below to confirm installation of the Vaisala Veriteq vLog 4.5 software.  All Vaisala Veriteq 
USB cables should be unplugged prior to beginning the software installation process. 

Note: The software must only be installed on a PC that has passed the Hardware Requirements and 
Configuration qualification (Section 6.4 of the vLog IQ/OQ Protocol). 

Step Procedure Expected Results 

Are actual 
results as 
expected? 

Initials/Date 

6.5.1 
Enter the PC ID for the computer used:  
 
______________________________________ 

The PC ID is recorded.  

6.5.2 
Insert the Vaisala Veriteq vLog 4.5 software CD 

into the computer’s CD drive. 

The software installation manager starts and the 

Select Setup Language dialog box appears.
 
 

 

6.5.3 
Select English from the dropdown menu and 

click the OK button. 

The Welcome to the Vaisala Veriteq vLog Setup 

Wizard dialog box appears.    

 

6.5.4 
Click the Next button. The License Agreement appears.                   

6.5.5 
Select the I accept the agreement radio 

button. 

You have accepted the terms of the license 

agreement.                                                        

 

6.5.6 
Click the Next button. You are asked to enter the vLog Security Key.  

6.5.7 
Enter the vLog Security Key (as found on a 

label on the CD case). 

The security key has been entered.  The code 

should be kept confidential. 

 

6.5.8 
Click the Next button. The Select Destination Location screen appears.       

6.5.9 
Accept the default location (or click the Browse 

button to select a different folder) by clicking the 

Next button.   

The installation location is set.  The Select Start 

Menu Folder screen appears.           …..                                     

 

6.5.10 
Accept the default folder (or click the Browse 

button to select a different folder) by clicking the 

Next button.   

The Start menu folder is set.  The Select 

Additional Tasks screen appears. 

 

6.5.11 
If desired, check the Create a desktop icon 

box.  Click the Next button. 

The Ready to Install screen appears.              (SS)  

6.5.12 
Confirm that the installation information is 

correct.  Click the Install button. 

Be sure to unplug any Vaisala Veriteq USB 

cables from the computer.  A message will pop 

up advising you to do so before proceeding.  

Unplug the cables and click the OK button to 

proceed. 

If you have a previous version of vLog installed, a 

box asking Would you like to uninstall vLog 

<version number> now? will appear.  Proceed to 

Step 6.5.13. 

If this is a fresh installation, skip to the Expected 

Results for Step 6.5.15. 
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Step Procedure Expected Results 

Are actual 
results as 
expected? 

Initials/Date 

6.5.13 
Click the Yes button to uninstall the previous 

version of vLog. 

The vLog – InstallShield Wizard asks if you wish 

to completely remove the application and its 

features.                                                             

 

6.5.14 
Click the Yes button. The vLog – InstallShield Wizard confirms that the 

program has been uninstalled.                                         

 

6.5.15 
Click the Finish button. The Completing the Vaisala Veriteq vLog Setup 

Wizard screen appears. 

 

6.5.16 
Click the Finish button. vLog is unable to find the security file and asks if 

you would like to create one. 

 

6.5.17 
Click the Yes button. The vLog Security Wizard opens.                     

6.5.18 
Click the Next button. The vLog Security Wizard page is shown, 

prompting the user to enter the CD security key. 

 

6.5.19 
Enter the CD security key, and click the Next 

button.  (The security key is found on a label on 

the CD case.) 

Upon successful security key entry, the vLog 

Security Wizard administrator account setup page 

is shown.                                                            

 

6.5.20 
Enter a User name and Password for an 

existing valid Windows account, and the Full 

name by which the user is identified.  Click the 

Next button. 

Note: This user will be granted vLog 

ADMINISTRATOR status.   

Upon successful entry of administrator’s details, 

the wizard prompts the user to specify the audit 

trail folder location.                                            

 

6.5.21 
Accept the default location (or click the … 

button to select a different folder) by clicking the 

Next button. 

The Security Level page is shown.                                                               

6.5.22 
Select the High security radio button. High security is selected.                                  

6.5.23 
Click the Finish button. The vLog program starts.  

6.5.24 
Click Help > About Veriteq vLog from the 

menu bar. 

The Veriteq vLog box appears, displaying the 

software version that was installed.                   (SS) 

 

6.5.25 
Click the Veriteq vLog box. The Veriteq vLog box disappears.  

6.5.26 
Click File > Exit. vLog closes.  

1
If the CD Autorun feature is disabled on your system, the installation must be manually started by double-
clicking on the file D:\SETUP.EXE, where D: is the letter of your CD-ROM drive. 
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Comments/Deviations:   

  

  

  

 

Acceptance Criteria:  All Expected Results have been met and the Vaisala Veriteq vLog Version 4.5 
software is installed successfully.  

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.6 Test User Security Level Information 

Using the Administrator account set up in Step 6.5.20, create the local vLog accounts as listed below.  If the 
vLog Administrator account created during software installation is not the “administrator” account you wish to 
use during the protocol execution, create a second “Admin” account.  These accounts will be used during 
the Operation Qualification testing.   All accounts use Windows authentication.   

Note: The User and Guest accounts must be either 2 existing Domain accounts, or new Local accounts 
created in advance by the Local Administrator. 

Step Procedure Expected Results 

Are actual 
results as 
expected? 

Initials/Date 

6.6.1.1 

Log in to vLog using the administrator’s User 
Name and Password. 

The software opens.  

6.6.1.2 

Click Tools > Administrator Options. The Administrator Options window opens.  

6.6.1.3 

On the Security tab, click the Add button. The Add User window opens.                        

6.6.1.4 

Configure the new user with the following 
settings: 
User Name:   User1 
Log on to:       <Local> 
Full Name:      User1 
User Role:      User 

The new user, User1, is configured as per the 

instructions.                                                    

 

6.6.1.5 

Click the OK button. The Add User window closes.  User1 appears 

in the User name column.                             

 

6.6.1.6 

Select User1 and click the Test button. The Test User Account window opens.        

6.6.1.7 

Enter the Windows Authentication password 
and click the OK button. 

The message The specified user credentials 

were successfully authenticated in Windows 

appears.                                                        (SS) 

 

6.6.1.8 

Click the OK button. The message closes.  

6.6.1.9 

Click the Add button. The Add User window opens.  

6.6.1.10 

Configure the new user with the following 
settings: 
User Name:   Guest1 
Log on to:       <Local> 
Full Name:      Guest1 
User Role:      Guest 

The new user, Guest1, is configured as per the 

instructions.                                                    

 

6.6.1.11 

Click the OK button. The Add User window closes.  Guest1 appears 

in the User name column.                             

 

6.6.1.12 

Select Guest1 and click the Test button. The Test User Account window opens.        
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Step Procedure Expected Results 

Are actual 
results as 
expected? 

Initials/Date 

6.6.1.13 

Enter the Windows Authentication password 
and click the OK button. 

The message The specified user credentials 

were successfully authenticated in Windows 

appears.                                                        (SS) 

 

6.6.1.14 

Click the OK button. The message closes.  

6.6.1.15 

Click the OK button. The Administrator Options window closes.  

6.6.1.16 

Click File > Exit. vLog closes.  

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria:  All test users have been configured to have correct access level to the Vaisala 
Veriteq vLog software via the vLog user logon.   

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.7 IQ Final Approval 

The procedures in this section have been implemented, reviewed, and approved by the individuals listed 
below.  All results have been documented and all deviations have been identified, documented, reviewed, 
and approved.   

Note:  The Final “Approvers” should be the same as the original protocol approvers when available. 

Upon final approval, OQ testing may commence. 

 

Implemented by (Signature): _____________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Reviewed by (Signature):  _______________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by (Signature):  _______________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

QA Approved by (Signature): _____ ________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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7 Operational Qualification Methodology 

7.1 Test Plan 

Testing will be performed to verify that the operation of the Vaisala Veriteq vLog System is in conformance 
with manufacturer’s specifications and customer requirements.  The Acceptance Criteria for all sections are 
derived from Vaisala Canada’s recommendations.  The test plan will consist of four main sections, as 
defined below.   

7.1.1 Functional Testing 

Functional testing will verify the following capabilities of the Vaisala Veriteq vLog software: 

- Vaisala Veriteq vLog Software Setup 

- Logger Communication 

- Batch Transfers 

- Graph Files 

- Graph Titles 

- Time Axis Settings 

- Scrolling and Zooming 

- Logger Files and the Cursor 

- Multiple Logger Files 

- Axis Units and Range 

- Printing of Secure and Non-Secure Logger Files 

- Data Integrity and Security 

7.1.2 Statistical Testing 

Statistical testing will ensure that the data within the files is correctly displayed, and calculated to 
provide validated results. 

- Instantaneous Value Reports 

- Channel Minimum, Maximum, and Average Reports 

- Channel Statistical Deviation Reports 

- Group Minimum, Maximum, and Average Reports 

- Group Statistical Reports 

- Channel and Group Mean Kinetic Temperatures 

- Lethality 

 

7.1.3 Audit Testing 

Uneventful testing will test the Auditing of Vaisala Veriteq vLog System interaction as a whole, and will 
consist of the following parts: 

- Linking Loggers to an Audit Trail 

- Single Logger Processing 

- Batch Logger Processing 
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- User Account Privileges 

- Account Security 

- Audit File Integrity 

- Security File Integrity 

- Batch File Integrity 

, 

7.1.4 Eventful Testing 

Eventful testing is concerned with testing unexpected events.  The tests will verify that the Vaisala 
Veriteq vLog System can handle these unexpected events with no loss or corruption of data.  These 
events are: 

- Logger Disconnection During Transfer 

- System Power Loss During Transfer 
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7.2 OQ FINAL APPROVAL 

The procedures in this section have been implemented, reviewed and approved by the individuals listed 
below.  All results have been documented, all generated reports have been attached to this document and 
all deviations have been identified, documented, reviewed and approved. 

 

Implemented by (Signature):______ ________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Reviewed by (Signature):_________________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by (Signature):_________________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

QA Approved by (Signature): _____________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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8 Signature Identification Form 

All personnel assigned to execute or review this executed protocol, attached deviations, modifications and/or 
supporting documentation must sign and initial in the space provided below.  Signature also indicates the 
individual has read and understands the protocol prior to task execution.  In the affiliation and title 
column fill in company name and designated title. 

 

Printed Name Signature Title/Affiliation Initials/Date 

    

    

    

    

    

    

    

    

    

    

 

Comments/Deviations:   

  

  

  

 
 

Implemented by:   _______________________________________ Date: _____________ 

Reviewed by:      _______________________________________ Date: _____________ 
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9 IQ/OQ DOCUMENT FINAL APPROVAL 

 

The Vaisala Veriteq vLog System has passed all tests, and as such, is qualified to be used in the 
_________________________environment: 

      

 

Reviewed by (Signature):  _______________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by (Signature):  _______________________________ Initials: ______ Date: _______________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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10 DOCUMENT HISTORY 

Note:  This section is for internal tracking purposes and may be omitted depending on your procedure for 
validation document revisions, SOP #______ . 

 

Document # Description of changes Date By 

    

    

    

 

 

 

 
 


